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Communication with Instructor 

Contact information for the instructor is listed at the beginning of this syllabus. Email is 
the instructor’s preferred mode of communication. The instructor will respond or at least 
acknowledge email messages from students within a maximum of five (5) business 
days when MSU is in session. Beyond standard university holidays and breaks, the 
instructor will notify students of any extended periods of time when email contact is not 
practical (professional meetings, etc). 
  
When emailing the instructor, please include your full name, course and section 
number, and a thorough explanation in your message. This will help expedite 
your request or needs. 
  
The student should also periodically check the News section within D2L for course 
updates and other important information. 
  
If you are having technical difficulties accessing the course or any other technical issues 
please contact distance.learning@msutexas.edu .  
  
 

Course Overview 
The focus of this course is to provide an interdisciplinary data analysis class specifically 
for health sciences and human services majors using techniques and data structures 
relevant to clinical investigations. General topics include choosing correct procedures 
and using statistics to understand clinical data. Specific topics include but are not limited 
to basic statistics, measures of correlation and difference, hypothesis testing and bias, 
confidence intervals, reliability and validity, significance, power analysis, levels of 
evidence, sample size and distribution, assessing effects of treatment, quality 
improvement, relative risk and relative risk reduction, and odds ratio. 
  
This is a three-credit course designed to teach the selection, application, and evaluation 
of statistical analysis techniques online.  There will be the same amount of material 
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covered in this course as a traditional classroom-based course and you will need to 
devote a substantial amount of time outside of the classroom mastering the material. 
Your responsibility for the online content includes but is not limited to, viewing chapter 
lectures and homework reviews, completing computer tutorial lessons, reading 
corresponding text material, participating in discussion forums, testing, and submitting 
assignments as directed by the professor and indicated on the class syllabus. You are 
responsible for checking the class D2l page daily.   
  

This is a very intense course that includes a great deal of material that builds on 
the previously presented material.  It is absolutely essential that you keep up with 
the class and do not fall behind.  Make sure you have scheduled adequate time to 
truly master the material each week.  Adding new material without understanding 
the previous work will only compound the problem making it very easy to find 
yourself with severe difficulties halfway through the course.  
  
Weekly content, including lectures covering the main topics, will be available within 
each unit.  In addition, a review of the homework assignments will be posted in each 
unit I HIGHLY suggest attempting the homework before you view the review of the 
problems.  What seems like a very straightforward topic can be much more 
difficult when you try to apply the concepts.  If you don’t try before you hear the 
answers you won’t know what you have difficulty with before moving forward 
with the material.  This will result in poor outcomes on your quizzes, and 
final.  Trust me on this one! 
  
Course Rationale:  Healthcare providers must be able to critique and understand the 
strengths and weaknesses of research design and analysis in order to be able to 
develop evidence-based practices in a clinical setting.  This course will prepare 
healthcare providers for the selection and application of statistical analysis techniques 
and the evaluation of the results derived from this analysis.  Students will learn various 
entry-level statistical techniques and analyze them within published clinical 
research.  This course is designed for the adult learner and involves extensive 
independent learning and mastery of subject material.  
  
  
Course Objectives 
Upon completion of this course, the student will: 

• Develop a broad-based understanding of descriptive statistics and selected 
statistical techniques 

• Choose and make the appropriate graph/table for a set of data Describe the 
characteristics of the normal distribution 

• Identify different levels of measurement. 
• Explain Type I and Type II error and the consequences of each error 
• Differentiate independent and dependent samples 
• Explain the effect of alpha, the number of tails, and sample size on the critical 

value of t. 



• Determine the power of an independent-samples t-test and the sample size 
necessary to have an independent-samples t-test with sufficient power. 

• Interpret the results from a chi-square test for contingency tables. 
• Choose an appropriate statistical test to use in analyzing a data set 
• Evaluate diagnostic and screening tests appropriately. 
• Understand the factors that form the basis for hypothesis and statistical testing. 
• Apply statistical outcomes to processes of quality improvement. 
• Use statistical outcomes to evaluate the effects of treatment. 

Textbook 
 

Heavey, E. (2019). Statistics for nursing. A practical approach, (3rd ed.). Burlington, 
MA: Jones and Bartlett. ISBN: 9781284142013 

  
Teaching Strategies 

Online delivery with asynchronous interactions between students and teacher, 
interactive discussions, quizzes, and a comprehensive final examination. 

Attendance 
This is an online course, and as such, there are no mandatory sessions. However, the 
students should be vigilant in checking their email and logging onto D2L. Regular 
checks will ensure messages from the instructor and fellow students are received in a 
timely manner. This course is on a schedule that will be strictly adhered to (see table 
below). The instructor will be available to meet face-to-face with any student who is 
interested. Please email the instructor to schedule an appointment. 
 

Evaluation 

            
            Quizzes                                   30% 
            Discussion Board                    45% 
            Comprehensive Final Exam    25% 

  
  

Grading Scale 

A = 90-100 

B = 80-89 

C = 70-79 

D = 60-69 

F =  59 and below 

  
  
Last Day for “W,” November 24 by 4:00 p.m. – Drops after this date will receive 
grades of “F.” Refer to the Undergraduate Bulletin for details about receiving a grade 
of “Incomplete” in a course. In an emergency or extenuating circumstance, a student 
may request a grade of “Incomplete” in a course before grades are submitted. If the 
instructor grants the “Incomplete,” the student has until thirty (30) days after the 



beginning of the next long semester to complete the course requirements.  If the student 
does not complete the course requirements within the deadline, the grade of 
“Incomplete” will automatically convert into a grade of “F.” 
  
Midterm Grades 
In order to help students keep track of their progress toward course objectives, the 
instructor for this class will provide a Midterm Progress Report through each student’s 
WebWorld account. [only at-risk students will be reported].  Midterm grades will not 
be reported on the students’ transcript; nor will they be calculated in the cumulative 
GPA. They simply give students an idea of where they stand at the midpoint of the 
semester.  Students earning below a C at the midway point should schedule a meeting 
with the professor. 
 
APPEAL OF COURSE GRADE 
Link to Appeal of Course Grade 
 
 

AI Statement 
Since writing, analytical, and critical thinking skills are part of the learning outcomes of 

this course, all writing assignments should be prepared by the student. Developing 

strong competencies in this area will prepare you for a competitive workplace. 

Therefore, AI-generated submissions are not permitted and will be treated as 

plagiarism. 

Assignments 
Assignments are a significant portion of the grade and represent the application of the 
material studied. All assignments are to be submitted as instructed in each unit. 
Assignments must be received prior to the deadline. Late assignments are not be 
accepted beyond the deadline. A zero will be recorded for assignments not submitted or 
meeting the final deadline. All assignments must be written at the baccalaureate 
level and will be graded for accuracy, completeness, quality, spelling, grammar, 
punctuation, and integrity.  
  
Required Software 
You must use Microsoft Excel software to complete some assignments. Microsoft Excel 
is the spreadsheet software included in Microsoft Office. I will provide instructions for 
using Excel. You will not be able to complete some of the assignments in Excel unless 
you add in the free Analysis Pak. To do this, follow the instructions below from 
Microsoft: (Applies To: Excel 2016, Excel 2013, Excel 2010, Excel 2007, Excel 2016 for 
Mac) 1) In Windows, go to Excel and click the File tab, click Options, and then click the 
Add-Ins category. (If you're using Excel 2007, click the Microsoft Office Button , and 
then click Excel Options. In the Manage box, select Excel Add-ins and then click Go.) If 
you're using Excel for Mac, in the Excel file menu go to Tools > Excel Add-ins. 2) In the 
Add-Ins box, check the Analysis ToolPak check box, and then click OK. • If Analysis 
ToolPak is not listed in the Add-Ins available box, click Browse to locate it. • If you are 
prompted that the Analysis ToolPak is not currently installed on your computer, click 
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Yes to install it. 3) The Data Analysis button appears on the Data Tab to the far right. 
This is where the formulas are. 

• Independent Reading Assignments 

Unit 1: Chapter 1 
Unit 2: Chapter 2 

Unit 3: Chapter 3 
Unit 4: Chapters 5, 6, & 7 
Unit 5: Chapters 8 & 9 
Unit 6: Chapters 11 & 13 
Final: Review all chapters covered in the course 

  
*Supplemental note outlines and chapter review questions/videos are provided 
within D2L to help guide the reading assignments. 

• Discussion Board (45%) 

The discussion board is a mandatory component in this course. All initial posts are 
due by Sunday at midnight the first week the unit is open.  Response posts are 
due by the due date listed for each unit. Assignments are made specifically for this 
board. Students are expected to complete the calculations and write formally (no 
shorthand or text messaging abbreviations) and use APA format and referencing 
when appropriate. Thoughtful responses, constructive critique of fellow students, 
and meaningful participation are expected. Keep in mind the discussion board is a 
formal assignment and part of your final grade. Late discussion board posts are 
not be accepted beyond the deadline. A zero will be recorded for 
assignments not submitted or meeting the final deadline. All assignments 
must be written at the baccalaureate level and will be graded for accuracy, 
completeness, quality, spelling, grammar, punctuation, and integrity. Review the 
grading rubric for each discussion board assignment. 

  
• Quizzes (30%) 

In each of the units, a quiz will be administered within D2L. These quizzes are 
open book, open notebook, but you will only have one hour to complete them and 
must be prepared as there will not be enough time to research every answer. 
Quizzes must be completed prior to the expiration dates listed in this syllabus. 
Quiz grades and answers will be released after the deadline of each quiz. Specific 
questions regarding the quizzes may be addressed to the instructor. Quizzes will 
not be made up if missed and zero (0) will be recorded. No extra credit 
activities are available. 
  
If students have technical difficulties during a quiz, they should use the “Report a 
Problem” link located on the top toolbar within D2L to contact the MSU distance 
education Support Staff and send an email to the course instructor explaining what 
happened.   

• Final Exam (25%) 



The final examination is comprehensive and consists of 50 randomized multiple-
choice questions; with five questions from each chapter. You will have 120 minutes 
to complete the final examination.  You will be required to use LockDown Browser 
and Monitor (Webcam).  Make sure you have the most recent version of the 
LockDown Browser on your computer. You can install the latest version 
here: https://msutexas.edu/distance/lockdown-browser.php. Chromebook Laptops 
are NOT compatible with the LockDown Browser, so you will need to locate a 
different device for the final exam. The Final Examination can be taken any time 
between the exam open dates that are listed in the syllabus. You must complete all 
module tests prior to taking the final examination. You will need to show your ID in 
Respondus before it will allow you to take the exam (so have your photo ID  close).  

10pts will be deducted from your exam grade if you do not do a thorough room 
scan, and 5 pts will be deducted for each time you leave the room while testing. A 
thorough room scan includes the area around you and behind the computer. You 
are expected to take this exam alone without anyone in the room.  

Tentative Course Schedule 

(All assignments are due at midnight Central Standard Time (CST) 

Date Module Opens Assignment 
Initial Discussion 
Post-Due 

Response 
Posts/Quiz Due 

Monday, Aug. 25 
Unit 1 Quiz 
Unit 1 Discussion Board 

Sunday, Aug 31 Monday, Sept. 8 

 
Syllabus Agreement is Due 
Aug. 31 

  

Monday, Sept. 8 
Unit 2 Quiz 
Unit 2 Discussion Board 

Sunday, Sept. 14 Monday, Sept. 22 

Monday, Sept. 22 
Unit 3 Quiz 
Unit 3 Discussion Board 

Sunday, Sept. 28 Monday, Oct. 6 

Monday, Oct. 6 Unit 4 Quiz 
NO DISCUSSION 
BOARD 

Monday, Oct. 20 

Monday, Oct. 20 
Unit 5 Quiz 
Unit 5 Discussion Board 

Sunday, Oct. 26 Monday, Nov. 3 

Monday, Nov. 3 
Unit 6 Quiz 
Unit 6 Discussion Board 

Sunday, Nov. 16 Monday, Nov. 24 

Nov. 26 – Dec. 1 Thanksgiving Break 
  

Final Exam Opens, 
Monday, Dec. 1 , at 
8:00 AM (CT) 

Final Exam Closes Friday, 
Dec. 5 at 10:30 PM (CT) 

  

 

  
Services for Students with Disabilities  
In accordance with Section 504 of the Federal Rehabilitation Act of 1973 and the 

Americans with Disabilities Act of 1990, Midwestern State University endeavors to make 
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reasonable accommodations to ensure equal opportunity for qualified persons with 

disabilities to participate in all educational, social, and recreational programs and 

activities. After notification of acceptance, students requiring accommodations should 

make application for such assistance through Disability Support Services, located in the 

Clark Student Center, Room 168, (940) 397-4140. Current documentation of a disability 

will be required in order to provide appropriate services, and each request will be 

individually reviewed. For more details, please go to Disability Support Services. 

Obligation to Report Sex Discrimination under State and Federal Law 

Midwestern State University is committed to providing and strengthening an 
educational, working, and living environment where students, faculty, staff, and visitors 
are free from sex discrimination of any kind. State and federal law require University 
employees to report sex discrimination and sexual misconduct to the University’s Office 
of Title IX. As a faculty member, I am required to report to the Title IX Coordinator any 
allegations, personally observed behavior, or other direct or indirect knowledge of 
conduct that reasonably may constitute sex discrimination or sexual misconduct, which 
includes sexual assault, sexual harassment, dating violence, or stalking, involving a 
student or employee. After a report is made, the office of Title IX will reach out to the 
affected student or employee in an effort to connect such person(s) with resources and 
options in addressing the allegations made in the report. You are also encouraged to 
report any incidents to the office of Title IX. You may do so by contacting: 

Laura Hetrick 
Title IX Coordinator 
Sunwatcher Village Clubhouse 
940-397-4213 
laura.hetrick@msutexas.edu 
 
You may also file an online report 24/7 at Reporting Link 

Should you wish to visit with someone about your experience in confidence, you may 
contact the MSU Counseling Center at 940-397-4618. For more information on the 
University’s policy on Title IX or sexual misconduct, please visit website 
  
Honor System 
NURS/RADS/RESP/SOWK 4123 adheres to the MSU Code of Conduct. In particular, 
academic dishonesty, however small, creates a breach in academic integrity. A 
student’s participation in this course comes with the expectation that his or her work will 
be completed in full observance of the MSU Code of Student Conduct. A student should 
consult the current Student Handbook for answers to any questions about the code. 
  
Many components of NURS/RADS/RESP/SOWK 4123 are designed to be highly 
interactive with students helping each other learn. Students are encouraged to take full 
advantage of many resources available including online D2L course resources, Internet 
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sites, other textbooks and journals, faculty, and peers when answering objectives. This 
interactive collegial learning environment is conducive to lifelong learning. 
  
Specific components of NURS/RADS/RESP/SOWK 4123 are designed to represent the 
efforts of each student individually and are not to be shared or copied (plagiarized) from 
other sources. These components include the discussion board, group activities, 
module quizzes, and the comprehensive final exam. When students submit their efforts 
for grading, they are attesting they abided by this rule. 
Cheating includes, but is not limited to: (1) use of any unauthorized assistance in taking 
quizzes, tests, or examinations; (2) dependence upon the aid of sources beyond those 
authorized by the instructor in writing papers, preparing reports, solving problems, or 
completing other assignments; or (3) the acquisition of tests or other academic 
materials belonging to the university faculty or staff without permission. 

Plagiarism includes, but is not limited to: the use of, by paraphrase or direct quotation 
without correct citation in the text and on the reference list, the published or unpublished 
works of another person. Students may not submit papers and assignments that they 
have previously submitted for this or other courses. The use of materials generated by 
agencies engaged in "selling" term papers is also plagiarism. Students are encouraged 
to review the tutorials and suggested websites for more information about 
plagiarism. Papers and other assignments may be submitted to an external agency for 
verification of originality and authenticity. 
Academic dishonesty (cheating, plagiarism, etc.) will not be tolerated in this 
class. Whenever a student is unsure of whether a particular situation will be interpreted 
as academic dishonesty, the student should ask the instructor for 
clarification. If students are guilty of academic dishonesty, a grade of zero (0) may be 
given for the quiz, assignment, etc. Cases may also be referred to the Dean of Students 
for possible dismissal from the university. 

Note: By enrolling in this course, the student expressly grants MSU a “limited right” in 
all intellectual property created by the student for the purpose of this course. The 
“limited right” shall include, but not limited to: the right to reproduce the student’s work 
product in order to verify originality and authenticity as well as for educational purposes. 
Specifically, faculty may submit student papers and assignments to an external agency 
to verify originality and authenticity to detect plagiarism. 
  
Administrative Process 

Unresolved issues related to this course should be first addressed between the student 
and the course instructor. If there is no resolution, students must follow this sequence: 

1. Director of Interdisciplinary Studies 

a. Dr. Randy Case (940) 397-4652 

2. Department Chair 

a. BSRS, Dr. Lynette Watts (940) 397.4833 

b. BSRC, Dr. Jennifer Anderson (940) 397.4656 



c. BSN, Dr. Robin Lockhart (940) 397-4614 

d. BSW, Mrs. Catherine Early, 940-397-4319 

3. College Dean, Dr. Jeff Killion (940) 397.4594 

4. Dean of Students, Matthew Park (940) 397.6273 

  

 

tel:19403974614

